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1 Introduction
This document’s aim is to provide instructions on setting up, installing, and configuring the 
Auditbase software. It also includes essential information on safety measures and 
troubleshooting.

Auditbase consists of a number of modules reflecting working operations at a hearing Audiology 
clinic.

Depending on your purchased licenses, some of the modules described in this document might 
not be available in your version of the Auditbase software. Please contact your distributor to get 
more information on the licenses.

The Auditbase system modules are provided with online help. To activate this function, press 
F1, Shift+F1, or select Help in the menu.

 Electronic instruction for use you can find here - Instructions for Use 
(auditdata.com).

For a detailed description of the Auditbase modules, see our User Guide.

Disclaimer:

This document is not intended to be a complete reference. For detailed information, please 
refer to the User and Admin Guides after installing the Auditbase software.
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2 Abbreviations and terms
Term Definition

AB Auditbase

ABR Auditory Brainstem Response (a hearing test to determine how 
the inner ear (cochlea) and the brain hearing pathways are 
working).

BSA British Society of Audiology

OAE Otoacoustic Emissions (a hearing test to determine how the 
inner ear (cochlea) is working).

QRP Technology for building reports using Team Developer

RPT Technology for building reports using Crystal Reports

IFU Instructions for Use
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3 Symbols used
Symbols are used in the system and in the documentation in places where this is required by 
regulations or where it is simply more convenient due to space restrictions. 

General Warnings

Warning in About Box labelling

Manufacturer address

 0123 CE mark and Notified Body number

Medical device

Electronic instructions for use (e-IFU)
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4 Compliance with standards
Auditbase application complies with the following standards:

№ Nomenclature Standard name

1  ISO/IEC  27001:2013 
+C1:2014 +C2:2015 
(Edition 2) 

Information  technology - Security techniques - Information 
security management systems -  Requirements 

2  ISO/IEC  27002:2013 
+C1:2014 +C2:2015 
(Edition 2). 

Information  technology - Security techniques - Code of 
practice for information security  controls. 

3  EN  60601-1-6:2010 
+AMD1:2013 CSV (Ed 
3.1) 

Medical  electrical equipment - Part 1-6: General 
requirements for basic safety and  essential performance - 
Collateral standard: Usability 

4  IEC  62304:2006 + 
AMD1:201 5 CSV 
(Edition 1.1), 

Medical  device software -- Software life cycle processes 

5  IEC  62366-1:2015 
(Edition 1.0) 

Medical  devices - Application of usability engineering to 
medical devices 

6  EN  ISO 14971:2019 
(Edition 3.0) 

Medical  devices - Application of risk management to medical 
devices 

7  EN  ISO 13485:2016 
(Edition 3.0) 

Medical  devices - Quality management systems - 
Requirements for regulatory purposes 

8  MDD  - 93/42/EEC 
(M5/2007) 

The  Medical  Device Directive  (Council Directive  93/42/EEC  
of  14 June 1993 concerning medical devices)

9  MDR  (EU) 2017/745  Medical  Devices Regulation (MDR) 

10  IEC  82304-1:2016  Health  software — Part 1: General requirements for product 
safety 

11  DCB  0129 Amd 
24/2018 Clinical Risk 
Management 

Clinical  Risk Management: its Application in the 
Manufacture of Health IT Systems 
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5 Intended use
Auditbase is a “Hospital Information System”

 l For storage and transfer of electronic patient records, archiving of documents and data 
related to a specific patient.

 l Various modules for recording, viewing and altering of clinical patient data.
 l The stored information is partly intended for aiding in decision making for correct 

treatment.
 l At the same time, Auditbase is not indicated as a sole means of diagnostics.

Product name Trade Name MDR 
Class

MDR 
Rule

GMDN Basic UDI-DI

2003 
Auditbase 

Auditbase Class IIb 11 61087 05711781DHF2003-
12Z

According to MDD Class I.

 

5.1 Intended medical population and purpose
Auditbase is divided into separate modules, which are installed in a single package.  Some 
modules have a slightly different medical population and purpose from others hence they are 
described separately here.

The Auditbase modules are used by Audiology, Implant teams, ear surgeons in public and 
private Hospitals. The clinics provide services to patients with hearing loss.

The Auditbase is not indicated as a sole means of diagnostics.

The Auditbase Audiogram module is a software device intended for recording the 
measurements of hearing loss to aid in decision-making of the correct treatment for that 
hearing loss and the suitability of the patient for a specific type of hearing instrument.

The Auditbase Implant module is a software device intended for recording the measurements 
of hearing loss and speech and language discrimination for aiding in the decision-making of the 
correct treatment for hearing loss in the determination of the suitability of the patient for a 
specific type of (cochlear) implant.

The Auditbase Surgery module is used for recording what has been done at each stage of the 
patient pathway.   The Auditbase Surgery module is not used in the process of making a 
diagnosis on the preferred treatment of the client’s hearing condition; it is used for manually 
recording and monitoring the decisions and actions taken.

Auditbase 6.9.0
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The ABR/OAE module is used for manually recording the results of diagnostic or screening ABR 
and OAE measurements.  Results of the measurements may be used in the process of making a 
diagnosis on the preferred treatment of the client’s hearing condition.

The Auditbase Questionnaire module is used for manually recording the results of audiological 
questionnaires before and after treatment.  Results of the questionnaires may be used in the 
process of making a diagnosis on the preferred treatment of the client’s hearing condition.

All modules can be used in every installation.

 

5.2 Intended user profile
Auditbase is divided into separate modules, which are installed in a single package.  Some 
modules have a slightly different intended user profile from others hence they are described 
separately here.

Auditbase audiogram module 

The Auditbase Audiogram module is typically used by the audiologist personnel in an 
audiological clinic. Typical user roles are the following:

 l Audiologists;
 l Users in the read-only (limited view) mode, typically in not audiology departments.

Auditbase Implant module 

The Implant Module is used by Implant teams in public Hospitals. Typical user roles are the 
following:

 l Speech and Language therapists;
 l Teachers of the Deaf;
 l Audiologists;
 l Implant surgeons.

Auditbase Surgery module

The Surgery Module is used by ear surgeons in public Hospitals. Typical user roles are the 
following:

 l Ear surgeons.

Auditbase ABR/OAE module

The ABR/OAE Module is used by Implant teams in public Hospitals. Typical user roles are the 
following:

 l Audiologists.

Auditbase questionnaire module
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The questionnaire Module is used by Implant teams in public Hospitals. Typical user roles are 
the following:

 l Speech and Language therapists;
 l Teachers of the Deaf;
 l Audiologists;
 l Hearing therapists.

Other modules in Auditbase are typically used by the personnel in an audiological clinic. Typical 
user roles are the following:

 l Clerical staff;
 l Audiologists;
 l Hearing therapists;
 l Repair specialists;
 l Trainees;
 l System administrators.

Users in the read-only (limited view) mode, typically in not audiology departments.

 

5.3 Auditbase modules

Patient Information 

Includes advanced search function, option to store an assessment overview for a patient, 
merge of patient data, patient group definitions, GP and patient demographics, automated 
notices and more.

Visit screens, history and outcome recording for Implant teams

Information recording for Implant teams

Patient tests and questionnaires

Tests and questionnaires used by audiologists, Speech and Language Therapists and Teachers 
of the Deaf.

Professional contacts including GPs

Professional contacts including GPs, Health Visitors, schools etc.

Booking module, patient communication and resource planning

Comprehensive appointment administration including advanced search function, task related 
time allocation, waiting lists and appointment letters, group appointments, resource use and 
link to referrals.
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Referral and Waiting list

Comprehensive, configurable and intuitive Waiting list and Referral modules with start, stop 
and suspend clock options to help comply with government pathway regulations.

Professional audiometry

There is the full ability to perform hearing tests using direct interfaces to manufacturer specific 
measuring equipment and to equipment with Noah compatible modules.

For manufacturers specific measuring equipment communication protocol is supported for 
communicating to software controlling that equipment.

Communication with the following software is supported:

 l OtoSuite Control panel;
 l Itera Control panel;
 l Primus Control panel;
 l AC440 Control panel.

For Noah-certified modules, information stored in Noah modules from any manufacturer 
supplying a Noah-certified audiometer and module can all be stored in Auditbase and accessed 
by the audiologist.

For Orbiter audiometer and Zodiac tympanometer it is limited to importing measurement 
results only without controlling the device.

For instructions and limitations on using all 3rd party audiometers mentioned above, see 
manufacturers’ user manuals for that software and audiometers operation (not provided along 
with Auditbase).

Store and retrieve detailed measuring results including audiogram comparison using trend 
graphs is supported. The audiometry module has multiple print options. Additional features 
include extended measurements, reports including audiogram and tympanometry data, 
detailed assessment plan for tinnitus patients or other issues (e.g. aural rehabilitation), 
protocols for vestibular testing and paediatrics.

Other measurements

OAE and ABR measurements.

Graphical speech

Outcome measurements for speech recognition applied in detailed graphical form with 
normative curves.

Journal module

Auditbase 6.9.0
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Handling of patient journals including signed and non-signed journal texts, the option to set up 
auto generated journal actions, the use of journal templates, extensive formatting and text 
editing based on user rights.

Task list

Define prioritised patient related or general tasks and add reminders and other notes with 
reference to an individual member of staff or in general.  Alerting can be set for  on screen 
and/or at log in.

Treatment summary

Configurable patient overviews (e.g. selected Journal notes, audiogram picture, assessment or 
paediatrics).

Paediatric module

Selection of specific paediatric features such as automatic calculation of age based on date of 
birth, management of family and contact information, referrals, audiogram data and free text 
consultation.

Stock module

Handling of serial number and quantity controlled items including advanced search function 
and automated device issuing from Stock after fitting in Noah. Hearing instruments can be 
fitted using Noah compatible modules. Use a barcode reader for fast registration of stock.  Other 
features include user secure editing of stock status, order and stock transaction overview as 
well as purchase orders, loan and returned instruments history and ear moulds.

Barcode stock verification

Verify stock with a barcode reader for a fast and easy way of doing inventory.

Auditbase Check-in

Patients can self-register on arrival via a touch screen.

Day view         

An overview of patient and other appointments per location.

Location and Department Filtering

Handling of individual locations or departments with user or workstation related waiting lists, 
appointment/booking symbols, letters, stock types and documents specific to each location.

Auditbase 6.9.0
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Import/export module

Electronic exchange of data for instance in connection with patient transfer to another Trust or 
exchange of data with other systems for further adaptation.

Repair module

Handling of repairs to/from external parties (standard version) and handling of internal as well 
as external repairs, invoicing, expedition and more (full version).

Documents and attachments module

Handling of documents and file attachments for clients as well as those not related to clients 
e.g. document templates; with the possibility of making client related documents based on 
templates.

Statistical module

In depth statistics for appointments, referrals and stock.

 

5.4 Single current client
Global client is always maintained regardless of which module is open.  This is performed using 
an internal numerical patient identifier Patient ID independent of the external identifiers used 
by customers and users.

 

5.5 Limitations and constraints for using Auditbase
 l Auditbase must be used by users who meet the Intended user profile described above.
 l Auditbase must be used by trained users who have read and understood this Instruction 

for use.
 l Auditbase is intended to be used in Audiological clinics.
 l User full names registered in the system must be unique because Noah does not work for 

users with duplicated names.

 

5.6 Clinical benefit
The use of Auditbase provides a clinical benefit since it contributes to the diagnosis of hearing 
impairments and their timely treatment.
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6 Precautions and safety
6.1 Warnings, precautions and contraindications

 Be sure to observe the   safety requirements stated in this instruction, both during 
installation   and use of this system. 

 l Be warned that Auditbase is intended to be used as part of an overall diagnosis and 
treatment process.  Decisions should not be taken which could affect the safety of 
patients without reference to other ways and methods of assessment.  Any findings 
should be confirmed with the patient before taking action and users should be alert to 
confirm any data with the patient which they suspect of being incorrect.

 l The system the user is using has to fulfill the minimum system requirements in order to 
mitigate the risk that patient data cannot be read for the database where network latency 
is too high or the screen does not fit all the data where screen resolution is too low.

 l PAS update: please ensure the client is the same as requested before saving.
 l To avoid unauthorized persons accessing the system, make sure your password is secure 

enough in terms of length, complexity, and unpredictability and do NOT disclose it to 
anyone.

 l For security, the System Administrator password must be changed at first use and must 
only be shared with persons nominated to make configuration changes.  This password 
must be changed on a regular basis.

 l If you have forgotten your password, you must contact your System Administrator 
immediately to change it.  If you think you may have lost a record of it and someone else 
could have found it, then you must inform your System Administrator immediately.

 l Double check you are assigning/associating correct rights/role, otherwise users can 
make inappropriate actions in the system.

 l To prevent unauthorised access to patient data users must not leave their PC 
unattended.

 l General search for a Client: be careful when exporting to CSV the results of client search 
as you might be running the risk of a PID (patient identifiable data) leak.

 l When using Noah Fast data view, do not forget to close the Fast Data View document 
manually since Auditbase cannot close it automatically. Be careful with patient content, 
Auditbase cannot warn users that a Fast Data View document is still opened for a client 
when users select a second client.

 l On the Client information screen, please ensure the e-mail address is correct; entering an 
incorrect e-mail can cause sending the client's data to a wrong addressee.

 l Auditbase is intended as a system for all patients from young children to elderly adults.  
There are no contraindications indicating any groups of patients that it should not be 
used with.

 l Users exporting the Onward referrals list to CSV must proceed with care when processing 
the file to avoid the loss/leak of patient data.
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 l Patient medical notifications must not be used as a single diagnostic tool. When onward 
referring a patient for further treatment, such notifications must be reviewed by qualified 
personnel alongside other patient data before any action is taken on the patient.

 l Auditbase functioning cannot be impaired when the software is used with other medical 
devices such as cardio stimulators, high-frequency electro-surgery units, defibrillators, 
shortwave therapy equipment etc., and does not endanger the patient. Additional 
equipment that can be used with Auditbase must comply with the requirements of IEC 
60601-1.

 l Auditbase can work in combination with printers and barcode scanners.  Auditbase will 
work safely with them and will not impair the specified performance of the devices where 
standard Windows drivers and software are used.  There is a restriction that barcode 
scanners must be able to simulate typing on the keyboard and must be able to produce 
prefix and suffix additions to the information string. There is a restriction that Zebra 
printers cannot be supported by Auditdata for printing labels.

 l It is essential that the Business Process ensures that training is in place to all users 
before starting to use Auditbase.

 l It is essential that the Business Process ensures that adequate resources are provided 
for client PCs according to the minimum system requirements. The Auditbase pre-install 
or pre-upgrade checklist must be accurately completed.

 l If a customer stops using Auditbase and wishes to dispose of it, then precautions should 
be taken to avoid unsafe disposal of media containing PID (patient identifiable data) and 
to avoid eradication of medical data before it is clinically safe to do so according to local 
laws.  See section ‘Stopping using Auditbase and disposal’.

 l Electronic instructions are provided instead of paper instructions. All users have access 
to the electronic version of the IFU available from the application itself. Users with access 
to a printer can, therefore, print a paper copy of the IFU themselves from the application.

 l If the customer requires a paper copy of the IFU, it can be provided within 7 days of the 
user's request to the support@auditdata.com.

 l Users exporting the Requisitions list to CSV must proceed with care when processing the 
file to avoid the loss/leak of patient data.

 l Users exporting the Security Log to CSV must proceed with care when processing the file 
to avoid the loss/leak of patient data.

 l When using the Oto Images module, users must ensure that all uploaded, imported, or 
pasted images are correctly linked to the correct patient.

 l In the Oto Images module, the manual sketching process and the default oval shape of 
the eardrum mean that the calculated percentage is only an estimate and should not be 
considered an exact measurement.

6.2 Be aware
 l BSA shadow masking symbols are not included in the Noah standard: therefore, they will 

not be transferred to Auditbase on saving the audiogram in Noah.
 l When working in any module, before proceeding with reporting or treatment decisions, 

please make sure the correct client is selected to avoid making an incorrect report or 
treatment.
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 l Created views should be used only on the screen resolution they were designed for to 
avoid issues such as not visible data and incomplete panes. When configuring the Client 
Summary on a high-resolution screen, note that it may not display correctly on lower-
resolution screens, potentially omitting some information. To avoid confusion, it is 
recommended to include the resolution size in the configuration name if it is especially 
high.

6.3 Residual risks and undesirable side effects
Auditbase does not contain residual risks of an unacceptable level and undesirable side 
effects; all risks have been mitigated to an acceptable level by the system implementation 
process and documentation process. Please note that to maintain any risks at this acceptable 
level, warnings, precautions, and contraindications listed above must be carefully studied by 
users and followed in their daily work.

Please also be aware that the Clinical Safety Officer on site has the Clinical safety case report 
for Auditbase, where clinical risks are described in more detail, and the overall clinical risk 
summary for Auditbase is described.
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7 Installation, Setup and Operation
7.1 Installation and uninstallation

 l For full step-by-step guidelines on how to install the Auditbase System, refer to the 
Auditbase Complete Installation Guide.

 l Installation must be done by or with Auditdata support personnel assistance. Installation 
instructions can be found in the Complete Auditbase installation guide and Quick 
Auditbase installation guide available on the release CD.

 l There are no specific interface system requirements to be considered at the installation 
time. Optional interface requirements are available and can be discussed with your 
Auditdata representative.

 l Uninstalling Auditbase: See Auditbase Complete installation guide.

 l Minimum and recommended client and server specifications are outlined in Appendix A 
of this document.

7.2 Setup
 l The System Administrator referred to in this document uses the login SYSADM and a 

given password.

 l  For security, this password must be changed at first use and must only be shared 
with persons nominated to make configuration changes. The password must be changed 
on a regular basis.

 l Customers are recommended to employ Active Directory integration for login to Auditbase 
so that passwords are not in use, and they can employ multi-factor authentication to 
secure the Active Directory login.

 l Immediately after the initial Auditbase installation, options for secure password 
configurations and auto-logout must be considered. See the corresponding sections 
below.

 l Dependencies on other applications: Auditbase works with MS Word for processing 
documents, therefore, if processing documents is planned on the workstation, MS Word 
must be installed on that workstation,

 l For details on how to configure Auditbase, see Auditbase Admin Guide.

7.3 Preparing for strong authentication
Setting up user identifiers
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First, system administrators must choose an identifier for user identification and configure the 
settings on the External Authentication page in Auditbase Administration. The identifier options 
include:

 l User Global ID
 l Phone Number
 l Active Directory Account Name
 l Email
 l User Global ID 2

Administrators must then ensure this identifier is filled in for all users who will use external 
authentication. The identifier must:

 l Not be empty
 l Be unique

If these conditions are not met, users will not be able to log in after external authentication is 
enabled.

Configuring authentication settings

Configuration should be done on the External Authentication screen in Auditbase 
Administration. The site must decide which of the three authentication options to use.

Enabling authentication methods

Enabling external authentication is done in Auditbase Administration on the Authentication and 
Password Settings screen.
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If the general settings are OFF but external authentication is needed for some individual users, 
it can and be done on the User Rights and Setup screen.

Before enabling external authentication, it is recommended to "Check Active Users" on the 
Authentication and Password Settings screen. When external authentication is enabled, the 
system automatically performs "Check Active Users."

NOTE: When switching external authentication ON at the site level, the currently logged-in user 
must be able to pass the external authentication. Otherwise, the user will not be able to enter 
the system afterwards to resolve their authentication issues.

After that, it is necessary to conduct an authentication test using the Test authentication 
control. During this test, Auditbase waits for a response from the provider within the specified 
time-out period.

NOTE: Authentication test is a real authentication attempt. If the authentication is cancelled, 
the Administration tool will be inaccessible during this time.

SUCCESSFUL AUTHENTICATION

In case of successful authentication, the following message will be displayed.

The following notification will be shown in Auditbase.
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UNSUCCESSFUL AUTHENTICATION

If the user's ID is empty or does not match, the authentication process will fail. The system will 
report unsuccessful authentication:

7.4 Logging on

 It is essential that the Business Process ensures that training is in place to all users before 
starting to use Auditbase.

There are two ways to log into Auditbase:

 l With an Auditbase account
 l With a Microsoft Windows (Active Directory) account

You can use only one type of account to log into Auditbase.

To be able to log in with a Microsoft Windows account, your System Administrator should have 
configured your Auditbase account to use your Windows credentials and enabled the Auto login 
for Windows authentication.
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 1. Log in using a Microsoft Windows account

 l Double-click on the Auditbase icon on your desktop
 l Auditbase will log you in using your Windows credentials to the default database

If you want to log into a different database than the default database, you need to click the 

Windows icon ( ) and go to Auditdata > Auditbase with database choice.

2. Log in using an Auditbase account

 l Double-click on the Auditbase icon on your desktop
 l Choose your Database name (usually ABASE)
 l Enter your Username and Password
 l Click Login

Security: The system locks out a user after some number of attempts to enter the wrong 
password (configured, typically 3). A record of this event is included in the log. Unlocking the 
user account must then be done by the System administrator.

2.1. Logging in for the first time

Auditbase 6.9.0

© Auditdata – 2025, ID: DN02187/13, Date of issue: 23 December 2025

Instructions for use



23

When logging in for the first time or the first time after the System Administrator has changed 
your password, a message will be generated requiring  you to change your password before 
logging in.

If a quicker log in is required, your System Administrator can choose to load only the default 
module at start up. This will mean that opening subsequent modules will be slightly longer.

Symbols can be saved to the local PC which will mean that log in will again be slightly quicker. 
Your System Administrator can set up for the whole site, but this can be overwritten for a 
particular PC in Workstation Settings in the System Administration tool. 

After logging on, if Noah does not initialize properly due to poor performing PC, when the Noah 
Modules navigation shortcut tries to populate or when going to open Noah, a message bar will 
appear stating the problem.  A retry of the Noah initialization can be attempted from here by 
selecting the Reinitialise button.

If Auditbase or Viewer is opened directly from another system which passes the account and 
the password has been updated in that system and not in Auditbase, the login will fail and the 
new Login dialog will appear.

You may receive a message if a licence is already being consumed by this PC.  One message 
where it is under your user name and you can clear it and another where it is under another 
user name and you should contact the System Administrator.

Login details are linked to the signatures which are used to identify what has been done with a 
patient, and by whom, throughout the database. If the Username and Title history is changed 
due to a name change or job change then the signature will be changed from the date forward 
of the change. This information relates to all journal, document, stock and client related 
information held within the database. The historical information is maintained the signature for 
the items.

If Single Sign On is being used and has been set up for your account, double clicking the icon 
will automatically log you on to Auditbase.
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NOTE: The system Administrator account with login SYSADM is not permitted to log into 
Auditbase. The SYSADM account can be used to configure the initial privileged rights for users. 
All actions under this account will be logged as a named user.

3. Log in using strong authentication

Auditbase supports login using strong authentication methods from external sources, 
enhancing security and flexibility for users. Strong authentication can be utilised in two ways: 

 o In addition to traditional Auditbase Authentication: Users can log in using strong 
authentication alongside traditional methods such as passwords or Active Directory 
credentials.  

 o  Instead of traditional Auditbase Authentication: Users can opt for strong authentication 
exclusively, bypassing traditional login methods. 

If only external authentication is used (Auditbase authentication and Windows AD are not 
used):

The option to enter the user login and password is not available and the respective fields are 
disabled on the login screen.

If only one database is configured and authentication is set without SQLBase/AD login, then no 
login screen will appear, and the user will be logged in directly.

The option to change the password is disabled
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If the user ID is not found or the ID is not unique, one of the following messages are displayed.

 

Resolving login issues with Strong Authentication 

 o No users can log in: This problem occurs when all users must pass external 
authentication to log in to Auditbase, either in addition to or instead of the Auditbase 
login. The SYSADM user must log in to the Administration tool, review, and correct the 
settings, or switch off external authentication if the provider is unavailable.

 o Some users cannot log in: If only some users cannot log in, check each user's external 
identifier value, which must be unique and not empty. The system administrator should 
correct the global ID value or resolve the unavailability of the external authentication 
provider on the user's PC.

 o Disabling strong authentication: If external authentication issues cannot be resolved, it 
can be switched off for individual users on the User Rights and Setup screen or for site-
level settings on the Authentication and Password Settings screen in Auditbase 
Administration. The system will attempt to restore user passwords, but new passwords 
must be created if the password history was reset or for new users added during the 
external authentication period.
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7.5 Logging out
From anywhere in Auditbase, not Noah, you can logout quickly by pressing F2 and the login 
window appears for another user to login. The system will prompt you to save any entered or 
edited data.

Pressing the F2 button also allows you to change user. This is useful if you work on a computer 
where someone else is logged in.

NOTE: If you have a dialogue box opened and/or data unsaved and have logged off, it will not 
be possible to change the user to another one except for Administrator. 

Logging back in after F2 screens is now simplified (due to the removal of SYSADM). As a System 
Administrator, you can log in as the previous user after the user has logged out. When a user 
has logged out of Auditbase, click on Unlock. This enables you to choose the Administrator 
option, where you enter your System Administrator password and then click Unlock again. You 
are now logged into Auditbase with the previous user’s credentials. 

When exiting Auditbase a confirmation appears Are you sure you want to exit the application?  
This can be disabled in Auditbase Administration.

7.6 Password
If you mistype your user name and password more than three times, the Auditbase system will 
shut down.

There is also now the option to Lock the user out of Auditbase should an incorrect password be 
entered more than a certain number of times consecutively. The number of incorrect 
passwords allowed is determined by the System Administrator. If a correct password is entered 
then this resets the incorrect password count to 0. Should this happen the User account will 
need to be unlocked by the System Administrator.

Moreover, the System Administrator may choose to lock out accounts which have not been 
logged into for a period e.g. 3 months. Should this be the case then contact the System 
Administrator to unlock the account.

If you press Cancel, the login window closes and the system returns to Windows.

The system administrator manages the user name, password and expiration of password.

7.6.1 Change password

A user can change their password in Auditbase using the System settings -> Change password 
menu item:
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The password for the SYSADM account can be changed from Auditbase Administration using 
the File -> Change password menu item:

In the opened dialog, the user needs to enter the current password, the new password, and 
repeat the new password:

Expiry of password

When a password will expire in less than 5 days (counted from the latest change of password), 
the user will be notified and asked whether to change the password now or login without 
changing the password.

If a password has expired, the user must change the password in order to access Auditbase. It 
will not be possible in any way to access Auditbase without changing the password. Please 
contact the system administrator to change your password.

Format of new passwords
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 l A password cannot be empty and is limited to 8 characters
 l Old password must be entered in order to change it to a new one
 l Passwords can only contain characters between A to Z and 0 to 9
 l The first character in a password must be a letter from A to Z
 l You might not be able to reuse old passwords – how far back the history goes depends on 

the site setup
 l In the Change password window three mistakes in a row causes the window to close

 WARNING:  To avoid unauthorized persons accessing the system, make sure your 
password is strong enough in terms of length, complexity, and unpredictability and do NOT 
disclose it to anyone.

Lost or forgotten passwords

If you have forgotten your password, you must contact your System Administrator immediately 
to change it.  If you think you may have lost a record of it and someone else could have found it, 
then you must inform your System Administrator immediately.

Strong Authentication

Strong authentication can now be employed in addition to the use of an Auditbase password.  
When activated in Auditbase administration, the user will be required to be logged into 
Windows using the strong authentication method set by the administrator, otherwise they will 
be refused access to Auditbase.  Strong authentication could mean the use of a Windows smart 
card, biometric device or other method of logging into Windows.

Logging into Windows correctly will then allow a User to login to Auditbase.

7.7 Auto-log out (Screen saver)
Auditbase can be logged out temporarily manually or will logout automatically after a selected 
time if auto-logout is enabled to ensure that unauthorized persons cannot access the sensitive 
data in the system.  Screen saver settings can be fixed as a site wide rule or per work station.  
Site wide settings are set by the System Administrator and  workstation specific settings can be 
adjusted by assigned users with an Extended user right.  For security reasons, the Screen saver  
should be used every time the work station is left unattended. When the screen saver is 
activated the Auditbase system is locked by the latest logged on user. 

 l Activate the screen saver manually by pressing F2.
 l For automatic activation, settings should be defined in the System Administration tool. 
 l In the System Administration tool, you can decide if the screen saver automation should 

be Disabled or Enabled, and if so after how many minutes the screen saver should be 
activated.

 l At activation, if no changes have been made, the Login window is presented with 
following options for proceeding:
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 1. Unlock
 2. Login
 3. Exit 

 

Unlock

 l By pressing Unlock, the locked connection to the database is re-established (unlocked) 
and one of the options from the Application locked window should be selected to 
proceed:

 l Change user
Another user can log on to the Auditbase system. A warning that the present user’s 
unsaved data will be discarded will appear.

NOTE: If you have a dialogue box opened and/or data unsaved and have logged off, it will not 
be possible to change the user to another one except for Administrator. 

 

Login 

 1. Log in using a Microsoft Windows account
 l Double-click on the Auditbase icon on your desktop
 l Auditbase will log you in using your Windows credentials to the default database

 2. Log in using an Auditbase account
 l Enter user name and password of the user who was logged in at the time for the 

screen saver activation. The Auditbase system opens with the same status as 
before the screen saver activation.
If you enter the user name and password of a user other than the user who was 
logged in at the time of the screen saver activation, Auditbase system opens as a 
new instance without any data on the screen from the previous user

 

Exit

 l A warning that the user's unsaved data will be discarded appears and the Auditbase 
system closes.             

 l After performing a correct login, the user returns to the Auditbase system and thus to the 
window/screen, as it was when the screen saver was activated.

NOTE: The screen saver cannot be activated when Noah is running.

7.8 Changing the User Interface theme
When starting Auditbase in the new theme, you can always revert to the old theme as needed.

To change the theme:
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 1. In the System toolbar, click the Edit (Gear) icon
 2. Go to Current default theme
 3. Select Auditbase 5

However, when applying the Auditbase 5 theme, note that after changing the theme:

 l Only the UI color palette will change, the icons will not be reverted
 l Until Auditbase is restarted, some screens will have inconsistent color palette

7.9 Modules
Auditbase  consists of several modules that cover various areas of clinic and staff operations, 
for instance Booking, Stock, and Journal.

Licensed modules are accessible via the Navigation Pane to the left of the screen. 
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7.10 Noah4Auditbase subsystem
Noah is implanted in Auditbase using Noah4Auditbase, a wrapper to the functionality of Noah 
4, a unified system for performing client-related tasks.

Note: After upgrading to Noah 4, installation of Noah modules directly from the Auditbase 
system has been discontinued. Noah modules can be installed from either the Auditbase 
Installation menu or individually with the module installers. Please refer to the Auditbase 
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System Quick Installation Guide and Auditbase System Installation Guide documents 
respectively for detailed instructions.

With the Noah4Auditbase subsystem, you can:

 l Browse for Noah sessions to open them with the corresponding Noah module.
 l Select a Noah module from the list to open it.
 l Look through the client information.
 l After logging on, if Noah does not initialize properly due to poor performing PC, when the 

Noah Modules navigation shortcut tries to populate or when going to open Noah, a 
message bar will appear stating the problem.  A retry of the Noah initialization can be 
attempted from here by selecting the Repair button.

7.11 Sorting and saving listing screens
In any screen with a table listing, you can sort the list by a column by clicking on the column 
which you wish to sort by.

 l Hovering over the column title will display a message saying Click to sort column.

 l The first click will sort the column ascending, while the second click will sort the column 
descending.

 l You can also right-click on the column to Select sort order

In this window, you can change the default sort order with up to three columns.
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Back in the table listing, you can move around with the columns if you want a different view.

 l Hover the cursor over the bottom line of the column title box and a symbol appears.

 l Once the symbol is displayed, you can click and drag the column to a different location in 
the table.

You can also change the width of the columns by hovering over the separation line between two 
column title boxes, then click and drag to make the box either wider or smaller – the box to the 
left of the cursor will be affected.

Once you have set up the table listing to your preference, you can save that view as the default 
view.

 l Right-click on the table and choose Save user view.

Auditbase 6.9.0

© Auditdata – 2025, ID: DN02187/13, Date of issue: 23 December 2025

Instructions for use



34

 l If signed in as an administrator, the site default view can also be saved here.

Note: Certain modules in the application, like Journal, Client information and Booking, 
have customisable view options, which are saved by selecting Save window setup under 

the View menu. See descriptions of those modules for more information.

7.12 Column sort, word wheel search and scrolling
In most of the windows you can sort the tables based on a column and make word wheel 
search within the sorted column. When you point to the column header, you will see a tooltip if 
the table supports column sort and word wheel search.

To sort the table, click on the column header.

When you select any row in the table, a search for a matching row is done for each key you 
press. In most cases the search string is shown in the status bar of the main Auditbase System 
window. To jump to the next row meeting the search string criteria press Ctrl+Return key. To 
clear the search string press Backspace. 

Mouse scrolling

It is possible to scroll up and down through all tables using the mouse wheel.

7.13 Toolbar and initial screen
All of the icons on the menus have a text label or a tooltip to make it clear what the icon 
represents.             

The system toolbar contains the following:

 l A button to open and close the Navigation Pane. Orange surround if open, grey when 
closed.             

 l The selected client’s Date of Birth or Code no. as selected by the System Administrator.
 l The selected client’s name.
 l A drop-down list   to select from recent clients.
 l A button to switch to Client information .
 l A button to create a client’s treatment summary and show it . 
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 l A button to show client’s latest audiogram .
 l The name of the logged in User.
 l The current Location which can also be selected from the drop-down list.

 l Below this line, the active date, time and resource are shown.             
 l The Clinic filters and Clinic filters set up are also shown. 

The default module that will appear when you log into Auditbase can be defined by the user. 
Contact your System Administrator to learn how to do this.

The ribbon at the top of the page will display icons within the module you are currently using.  
The available icons and functionality will differ depending on the module you have selected.   
The ribbons all have icons grouped into tabs of File, Edit, Functions, and View. 

The ribbon can be displayed or closed.  Double click the selected ribbon tab to close the ribbon.  
Double click again to open it. 

The ribbon can also be auto closed or opened. First double click the selected ribbon tab in order 
to close the ribbon.  A single click of the ribbon tab will then open the ribbon temporarily, clicking 
one of the icons or clicking elsewhere on the screen will cause the ribbon to close again.  This 
allows for maxim screen space whilst still allowing ribbon access. 

The ribbon groups icons according to their functionality and gives them a title.  For instance, 
icons relating to search will be grouped and titled as such.  They will then be separated from the 
next icon group by a divider. 

Location and Department can be used for filtering with the Location Filtering licence; this is an 
optional extra for Auditbase.

You can make a single selection, select a Location group created by the System Administrator 
or make your own multiple selections.  A multiple selection is made by selecting the appropriate 
option from the Location or Department drop down list. A window will open where selections 
can be made by checking the box next to the name of the Location or Department.
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Once you have made your selection, OK will close the window or Cancel will close the window 
without any changes.

If multiple selections have been made, the Location or Department filter will display Multiple 
locations.  These choices can be seen by placing the mouse cursor over the filter and viewing 
the tool tip.  These selections are not saved, so if they are used regularly it is recommended to 
make Location groups as these are listed for ease of use.

7.14 Panes
Navigation to the left of the screen holds shortcuts to all Modules, Measurements, 
Questionnaires and Tests.  These are grouped into panes appropriate to their functionality.   The 
available panes are shown at the bottom of the Navigation area.  These panes will differ 
depending on the default view chosen by your System Administrator.  Those displayed below are 
the default Auditbase 5 grouping.

 n Individual client
 n Client pathway view
 n Clinic management
 n Stock management
 n User tasks
 n PPP lists

The size of the Navigation area can be changed. Drag the Navigation area divider left or right 
from its right border edge.  Click and drag the border using the mouse to re-size the viewing 
panes.

Select a pane appropriate to your needs and it will open showing its shortcuts above.  Selecting 
a shortcut from this list will cause it to open to the right of the Navigation area. 

Auditbase 6.9.0

© Auditdata – 2025, ID: DN02187/13, Date of issue: 23 December 2025

Instructions for use



37

7.15 User Favourites
From the available Modules, Measurements, Questionnaires and Tests, select shortcuts from 
any Pane that are of most use to you and create a Favourites list.
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Go to the Navigation area;         select the navigation pane -> right click a shortcut -> click Show in 
Favourites.

The selected shortcut will then be copied into your favourites list at the top of the Navigation 
area.

Your favourites list will always display at the top of the Navigation area.

Move your mouse to the divider at the bottom of the Favourites area until it changes to the 
cursor in the picture above to expand the pane allowing you to view its entire contents.  Both 
your favourites list and pane size will be remembered upon logging out of Auditbase.

Right click a shortcut and select Remove from favourites to remove from your favourites list.

To adjust the order the favourites list is displayed in, right click a shortcut and use the Move up 
or Move down options to give it a new placing.

7.16         Open, Close and Auto hide the Navigation Area 
 

 Click the icon to the left of the client name and the Navigation area will close. Click the 
same icon again to re-open the navigation area.  When open, the icon will be outlined in orange.

 When closed, the icon will have a grey surround.  Closing the Navigation area allows 
maximization screen use.

The Navigation area can be put into hidden mode, allowing screen maximization whilst still 
giving easy access to the Navigation area.
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 Click the small pin icon at the top right of the Navigation pane, the pin now displays 
horizontal.  Hidden mode is switched on.   Move away from the Navigation Pane and it will hide 
itself.

Take your cursor back to the Navigation area,  hover over the words Navigation.  The Navigation 
area  displays again.

When unhidden, you can select shortcuts from the Navigation area by moving your cursor into 
it and making your selection.

When using the auto hide function, the navigation open and close icon will be inactive.  You 
will need to use the pin icon to permanently open the navigation pane before the icon will 
become active again.

 Cause the Navigation pane to remain open by again clicking on the pin at the very top of the 
Navigation area.  The pin now displays vertically.

When the Navigation area open/close symbol is clicked and Navigation auto hide is in use, a 
warning message will appear.  To prevent the message appearing on future occasions, check 
the Don’t show this message again box. You can reset all messages to show again from within 
System Administration -> User settings -> User specific options -> Reset all checkboxes ‘Do 
not show this message again’ to show again.

Permanently close the Navigation area by clicking on the   at the top right of it.   Open the pane 
again by clicking the icon to the left of the client name.

7.17 Pane Configuration
The panes in the Navigation area can be configured to suit individual user preference.  At the 
bottom of the Navigation area and to the right of the last pane, is a small downward pointing 
arrow .  Click this to open options for configuring the panes.

Selecting Show Fewer Buttons will minimize the last pane title to just an icon at the bottom.    
Select Show Fewer Buttons again to minimize the next, last pane title. Clicking, Show More 
Buttons will cause them to be replaced as full headings.

Hover over Add or Remove Buttons  and a secondary menu will open.  From the secondary 
menu, you can remove headings from the list completely.  Replace the removed headings at any 
time by selecting them again in the same menu location.
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Selecting Navigation Pane Options from the menu allows you to adjust the order the headings 
are displayed in, as well as removing and adding headings to the list.

Selections made here are user unique and will be remembered by Auditbase upon logging out.

Navigation panes and  their contents can be decided upon by the System Administrator, 
therefore allowing limitation of what users may see and access.  The System Administrator can 
decide who accesses what by individual user, role or system wide access.

Keyboard shortcuts are shown on mouse-over in the Navigation pane.

7.18 Printing and output redirection
Auditbase System can set up a selection of default configurations including all printouts. Users 
can select one of these configurations as their workstation default, thus controlling how printing 
works.

For all system printouts in Auditbase, your System Administrator can configure their output 
redirection. The redirection option can be defined for each report separately, which means that 
the options may vary for different reports. The following options are available:

 l Send the printout to the application default printer (no redirection).
 l Send the printout to the Windows default printer.
 l Show Windows Print dialogue before printing. In the dialogue, you can select printer 

and number of copies.
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 l Send the printout to a file.
 l Send the printout to a file and attach the file to a new e-mail message. Additionally, for 

some reports processed with this option, the system copies the recipient e-mail address, 
if a relevant address exists in the system.

Note: To send a printout to a file and to send a printout to an email, the Printing/Output 
extension module needs to be licensed. Microsoft Office must be installed on the user’s 

PC, and the “Microsoft Office Document Image Writer” printer must be available.
User reports cannot be redirected.

The configuration described above is performed by the system administrator.

7.19 Help

The Help menu item has separate options for help file Contents, user guides or other 
Documentation, and how best to access Support.

7.19.1 Contents
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The entire help contents are displayed. Items can be searched for or individual items can be 
expanded to show subjects.  The content mirrors the User Guide.

7.19.2 Documentation

A number of documents can be viewed by selecting Documentation and then further selecting 
from the selection of documents. Double-clicking will open any of the individual documents if a 
PDF reader is installed.

7.19.3 Support

Profiling

For details, see the section on Profiling.

Remote support

Selecting this option will download the TeamViewer electronic support application.

On the opened site, select your language.
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After TeamViewerQS.exe is downloaded, open (launch) it.

Confirm running it using the Run button.
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Accept the license agreement.

Accept the disclaimer if your IT department will allow you to use the TeamViewer.
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Your Auditdata supporter will require the ID number and Password that are displayed.

Electronic support report

 l Selecting this option will produce an electronic report that can be sent to Auditdata.

Make a note of where the file is stored to, it should be your desktop, and then press Collect 
data. Once the information is collected, a confirmation message will be displayed.

A folder will be created on your desk top, containing two files. These files may be emailed to 
Auditdata to help resolve issues.
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Open Log Folder

Open Log Folder in the Help menu will open a window where certain log files are stored.  You 
may be asked by Auditdata support to send these files if you have reported an issue.  No client 
data is contained in these logs.

Contact us

Contact us will open the contact page on the Auditdata website.  

7.19.4 Profiling

Profiling is a support option in Auditbase, allowing users to collect information for developers 
about how the application is running.

It is practical when troubleshooting problems as profiling logs all system activity that can later 
be reviewed by the support team or developers. IMPORTANT: No client information is recorded.

Users can access Profiling from the Help menu in the System toolbar:

The following controls allow management of the Profiling functionality:

 1. Start: launches Profiling, which may potentially slow down the application
 2. Suspend: temporarily stops Profiling if performing other tasks requires full system 

capacity
 3. Continue: restarts profiling that has been suspended
 4. Stop: quits the Profiling mode
 5. Settings: contains additional Profiling settings
 6. Run at startup: launches Profiling at the next Auditbase startup
 7. Open Log folder: opens the folder with Profiling logs

Whenever Profiling is enabled, the corresponding banner will be shown. Users can obtain more 
information by clicking the Info button, or alternatively disable application logging by clicking 
Stop.
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Since turning on Profiling may affect the performance of the application, it is recommended 
that users go into the Profiling mode only when instructed to do so by Auditdata support 
specialists.

Settings

More advanced configuration options are accessible from the Settings window. Here you can 
configure the following:

 1. Folder for logs: use the default or specify your own folder
 2. Level: define the level of profiling. Extended level is recommended
 3. Run on the next Auditbase start: enable the launch of Profiling as soon as you start 

Auditbase
 4. Stop at: define the date when Profiling will be turned off. Double-clicking inside the box 

inserts the current date that can be modified as needed
 5. Automatically delete log files older than a specified count of days
 6. Keep file size not more than a predefined size in MB

7.19.5 About Noah

Use this menu item to view license information on the installed version of Noah. The 
information includes customer name, Noah serial number, license type, days left before license 
expiration, and number of users licensed to access the system.

7.19.6 About Auditbase System

Use this menu item or press F1 to see specific information on running the Auditbase System 
version.

You can see the revision number, build number, customer name, license ID, and the number of 
users licensed to access the system.
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For more information, see Appendix B.2 Label signs interpretation.

7.20 Accessibility options
Waiting list 

(Accessibility option) With the User option in Admin Waiting list type affected by refresh rule 
checked and Refresh Waiting list immediately after changing filter criteria? set to No, the 
user can step through the waiting lists and have them read by a screen reader without selecting 
them. To select it, press Enter. To open the drop-down list, press Alt + ArrowDn.

 

Booking – Timeplan

Enable the User option in Admin Show hours and minutes in every timeslot to have a screen 
reader read the time for each row.

With the Do not refresh Timeplan upper screen until selection confirmed in lower screen 
option  enabled, the Resource is not changed in the upper screen until Enter on the Resource 
row names in the lower section is selected.  This must be done before the user selects the 
Resource they want to view.

To ensure a screen reader can read the correct Resource name in the lower table, take care to 
allow enough time between selecting each resource.
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(Accessibility option) Press Alt+C to move focus to the calendar and here you can move 
between dates with arrows and PgUp/Dn keys.

 

Client search

With the user option in Admin "Search clients: Display message with search results after 
filling the table (Accessibility option)" checked, a message box displays the number of found 
clients upon completed search for a screen reader to read.

Use the space key to toggle the selection check mark.

 

Everywhere

(Accessibility option) Press F6 to call up a small dialogue with the selected patient's ID and 
name that a screen reader can read.

 

Client’s entries

(Accessibility option) The column with Appt. Symbol can be read by a screen reader if moved to 
the leftmost position in the saved user view.

7.21 Full operations guidance
Full operational guidance is available in Auditbase User Guide. This document is available from 
the Help menu described above.

7.22 Patient records when using Laptop synchronization
When a client is copied to the offline database, it is marked in the central database as "On 
laptop". Users will be warned of this when the client is selected as the global one. When a 
client's record is marked as offline, the user in the central database can continue to work 
without interruption and make changes to information there.

Information recorded in the central database cannot be altered on the laptop version. Only 
additional information and sessions can be recorded on the laptop, which prevents any 
conflicts of editing happening at the same time between the central and laptop databases. 
There is an exception for two-part questionnaires, such as COSI and GHABP. Although they are 
technically one record, the second part can be edited on the laptop after the first part is loaded 
from the central database. In this case:

 l Users in the main database receive a specific warning when they try to edit the Glasgow 
or COSI questionnaire for a patient on the laptop.
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 l During synchronization of the laptop database with the central database, the system 
overwrites data in the central database with data from the laptop for these 
questionnaires. If users complete the second part in both the central database and on 
the laptop simultaneously, the data from the laptop will prevail. However, if the 
questionnaire was not modified on the laptop, any changes made in the central database 
will not be lost.

New patients can be created in the laptop database and either added as new entries in the 
central database or merged with existing records during synchronization. Information such as 
demographics in the central database is maintained and not replaced by information from the 
laptop database.

7.23 Stopping using Auditbase and disposal
If users are to stop using Auditbase on some workstation then it is recommended to do the 
following actions:

 l Uninstall Auditbase using the standard Windows Add/Remove Programs functionality.
 l If an installation source is located on the workstation, it is recommended to delete it after 

uninstallation.
 l Please contact your local IT department for help.

If the entire site decides to stop using Auditbase, then:

 l Actions above must be done on every PC, where Auditbase is installed.
 l Installation sources should be removed from locations where products in use are stored 

but may be archived in locations intended for archiving purposes.
 l The Auditbase central database must be retained for the period of time regulated by the 

local law. Auditdata is not qualified to advise on this period; local laws regarding the 
retention of personal medical information must be followed. After that, the database 
must be deleted in an unrecoverable way using best practice processes available at the 
time by the local IT department or its agencies. Please contact your local IT department 
for help.
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8 Troubleshooting guide
If you have any problems with installing or running the software, please go through this guide 
first before contacting a Support/HOT-line.

Please verify that installation prerequisites are satisfied. For details, see Appendix A.

If all installation prerequisites have been met and you still have issues with your software, 
please refer to the tables below for the solution of your problem.

SQL errors

Issue Solution

9268 – Cannot connect Contact Local IT to check the network, server  and Gupta 
SQLBase service on the server.*

 

9024 – Session ended 
abnormally

Contact Local IT to check the network, server  and Gupta 
SQLBase service on the server. *

 

9028 – Session ended 
abnormally

Contact Local IT to check network, server  and Gupta SQLBase 
service on the server.  *

 

1102 – Security violation 
attempting to  access

Select the Error to show which table is affected.  Assign 
appropriate table rights in the  System administration tool -> 
Users, security and views -> User administration and  security -
> User rights and setup -> Roles.

 

803 - Fatal SQLBase System 
Failure

Stop all Auditbase activity. Contact Auditbase support.

805 – Insert/update of 
unique constrained  columns 
with duplicate data

Contact Auditbase support.  

*  If no issues are found, contact Auditbase support at support@auditdata.com 

 

Noah issues
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Issue Solution

For versions below 5.4.2 only.  

 l Using Phonak Target 7.1, Hearing Aid 
serial numbers cannot be read. 

Apply for upgrade to support@auditdata.com   

Noah token error when logging into Auditbase. Change your password from Booking -> 
System setting -> Change password.  Repeat 
if the message appears again.    

 l The password cannot be changed by 
the system administrator.  

For Noah versions below 4.13 (Auditbase 
version 6.1.0).

 l Noah validation fail (500)

See Noah's Data Validation Errors 

Noah problems after Windows 10 Upgrade. 

 l A problem with Noah initialization after 
an upgrade of Windows 10 (e.g., from 
1809 version to 1903), irrespective of 
the version of Windows 10.

 l An upgrade removes “Full control” 
permission from “Authenticated Users” 
in the HKEY_
USERS\.DEFAULT\Software\AuditData\
NoahDBInterface registry folder used for 
connection to Noah. 

There are 4 ways to fix the problem: 

 1. Add “Full control” permission for 
“Authenticated Users” in the registry 
folder HKEY_
USERS\.DEFAULT\Software\AuditData
\NoahDBInterface. 

1.1 Open the registry editor.   

1.2 Go to HKEY_
USERS\.DEFAULT\Software\AuditData
\NoahDBInterface. 

1.3 Right-click on the folder 
NoahDBInterface and select 
“Permission”.   

1.4 Click “Add” to add “Authenticated 
Users”. 

1.5 Add “Full Control” for 
“Authenticated Users” and click “OK”.    

 2. Run 
AddNoahPermissionToRegistry.exe as 
Administrator from the  folder 
AuditBase CD 
image\Auditbase\NOAH\RestoreRegis
tyPermission. 
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Issue Solution

 3. Copy all files from AuditBase CD 
image\Auditbase\NOAH\RestoreRegis
tyPermission, read the file readme.txt  
from the attached archive and run 
AddNoahPermissionToRegistry.bat  as 
Administrator. 

 4. Reinstall Auditbase.

 

Miscellaneous         

Issue Action

Auditbase is compatible with 
Windows 10 from  version 6.x.x 
only

To upgrade, apply by  email to support@auditdata.com  

 

More users logged in than 
allowed by licence

Check connections in the System administration tool -> 
Tools menu item -> Monitor  connections.  

Disconnect selected users.

Letters for keyboard shortcuts 
on  buttons and tabs missing 
underlines

This is now controlled by the settings in  Windows. If letters 
are not underlined, then: 

 l On Windows 10, go to Settings -> Ease of  Access -> 
Keyboard, then switch on the "Underline access keys 
when  available" option.

 l On Windows 7, go to Control panel -> Ease  of Access 
-> Change how your keyboard works, then switch on 
the  "Underline keyboard shortcuts and access keys" 
option.

 

Incorrect  version of gswag32.dll  l Copy the   files gswag32.dll, gswdll32.dll, 
from: C:\Program  Files (x86)\Gupta\Runtime62\

 l Paste to the  folder: C:\Windows\SysWOW64\

Repeat on each PC where the error appears.
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Issue Action

Installing 64-bit ODBC drivers For each PC  where you need to use the 64-bit ODBC 
connection:

 1. Make sure  ‘Enable Driver’ is NOT ticked in the 
Auditbase Administration (as this is  just for the 32-bit 
ODBC connection). It will not be ticked by default. 

 2. Install the C++ 64-bit runtime  libraries by running the 
file vcredist_x64.exe

Also available from: 

 l Download  Microsoft Visual C++ 2008 Service 
Pack 1 Redistributable Package MFC Security  
Update from Official Microsoft Download 
Center  (choose the x64 version)

 l Right-click and select ‘Run as Administrator’ to  
install

 3. Run  ‘Gupta SqlBase 64-bit drivers.msi’ to install the 
Auditbase 64-bit ODBC  drivers. 

These drivers are in the Auditbase installation, which 
can be found on your  sever at: 

 l \\twhaudio01\AB Install\Auditbase  
6.0.3.2.12346\Database\SqlBase drivers x64 
setup

 4. Manually  create the 64-bit ODBC connection:

 l Open the  64-bit ODBC Administrator from 
C:\Windows\System32\odbacad32.exe

 l Select  the ‘User DSN’ tab and select ‘Add’

 l Select  the ‘Gupta SQLBase 12.2 (64-bit) driver, 
then click ‘Finish’

 l ‘Configure’  the data source as shown below

 l Press  ‘Test Connect’ to check if it is working
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Issue Action

Once the connection is working, you should be  able to 
connect to the Auditbase ODBC from 64-bit applications 
(e.g., MS  Access).

Problem printing RPT reports 
from AB with Crystal 11 
installed. QRP reports are 
printed without any issues.

 

 

The problem is caused by an incorrect Crystal  XI runtime 
which might be installed together with some MS products. 

To resolve:

 1. Uninstall Crystal Reports XI runtime 

 2. Install Crystal Reports XI from Auditbase install 
media \Auditbase\CRXIRuntime.msi
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9 Operator roles and activities
9.1 Operator roles
The following are the operator roles generally expected to be involved in distribution, service 
and other activities with Auditbase.

 l Application distribution – responsible for the distribution of desktop applications 
(including through MSI packaging if required).

 l Auditbase administrator – responsible for configuration and setup of Auditbase including 
user creation, administration and authorisation.

 l IT security – responsible for maintaining IT security.
 l Database administrator – responsible for database backups.
 l Clinical Safety Officer – responsible for clinical safety.

 

9.2 Operator activities and recommended frequency

Operator role Activity Recommended 
frequency

Application 
distribution

Client application  installation On installation

Auditbase 
administrator

Configuring user permissions; updating their 
permissions  through modifying the relevant 
user roles

During user 
onboarding and after  
feature updates

Auditbase 
administrator

Revoking users Users leaving

Auditbase 
administrator

Evaluation of audit logs As required

Auditbase 
administrator

User  training on account security and 
password handling

During user 
onboarding and after  
feature updates

IT security Keeping anti-virus and malware protection 
up-to-date

Daily

IT security Ensuring operating system  security patches 
are up-to-date

Weekly

Database 
administrator

Monitoring backup Daily
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Operator role Activity Recommended 
frequency

Database 
administrator

Backup verification As required

Database 
administrator

Preparation for backup restoration As required

IT security/  
Auditbase 
administrator

Informing Auditdata regarding relevant 
security incidents

As required

Auditbase 
administrator/ 
Clinical Safety 
Officer

Informing Auditdata regarding relevant 
clinical safety incidents

As required

IT security Exchange of keys or  certificates As required
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Appendix A  
 It is essential that the Business Process ensures that adequate resources are provided for 

client PCs according to the minimum system requirements below.

The Auditbase pre-install or pre-upgrade checklist must be accurately completed.

 

A.1 Server specifications
A.1.1 Hardware requirements

Virtualised servers and SAN storage are fully supported by Auditbase. 

The minimum specification is aimed at existing installations being upgraded and should be 
discussed  with Auditdata support. New installations should always use the recommended 
specification or above depending on the number of users.

Hardware 
Component 

Minimum Recommended Comment 

1 - 10 concurrent users

Processor Xeon Dual  Core 
1.5 GHz 

e.g., E3 v31 
family 

Xeon Dual Core 2.0 
GHz 

e.g., E3 v31  family or 
above

Virtualised is supported                         

RAM 6 GB 12 GB  

10 - 200 concurrent users

Processor 2 Xeon Quad  
Core 2.0 GHz 

e.g., E7 v21 
family

2 x Xeon Quad Core 
2.0 GHz 

e.g., E7 v21  family or 
above  

Virtualised is supported                         

RAM 8 GB 12 GB  

All users

HDD Type SSD Fast SSD Fast SSD significantly 
improves performance

HDD Space DB(s) size x  3 + 5 DB(s) size x 5 + 10 GB Combined  active DB size. 
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Hardware 
Component 

Minimum Recommended Comment 

GB 

USB  2.0 3.0  

 

A.1.2 Software requirements

Software 
Component 

Description Comment 

Operating System Windows 2022 Server

Windows 2019 Server

Windows 2016 Server

For 64-bit  Server 32-bit 
application support must be 
enabled in order to run  essential 
tools.

All  Microsoft Updates should be 
installed.

Windows 2022 Server is only 
supported for SQLBase 12.3.0                         

Configuration Configure as ‘Application Server’ not 
‘File sharing’ where  available.  

‘File  sharing’ will reserve 41% of 
system memory.  

Database engine Gupta SQLBase 12.3.1

Gupta SQLBase 12.3.0

Gupta SQLBase 12.2.2

Supplied by  Auditdata. 

Minimum one port must be 
available for connecting to 
SQLBase, typically 2155.                         

Active Directory Optional. Auditbase  integration with Active 
Directory was tested on Windows 
server 2016, Active  Directory 
Schema 87.

Back-up facilities A document detailing recommended 
backup procedures can be requested 
through the normal Auditdata contact 
or via e-mail request to 
support@auditdata.com.

Auditdata can provide 
recommendations on how to 
perform backup but cannot 
implement or service these 
routines.*

*  Please be aware that Auditbase server backup is entirely the responsibility of the local IT department and that 
Auditdata cannot be held liable for any loss of data resulting from inadequate or inaccurate backup routines.
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A.2 Client specifications (including Noah installation)
A.2.1 Hardware requirements

Hardware   

Component   

Minimum   Recommended   Comment   

Processor   Core i5 Core i7  

RAM  32 bit: 4 GB  

64 bit:  4 GB  

32 bit: 4 GB

64 bit: 10 GB

A high level of memory is additionally 
needed by Noah fitting  modules.  If other 
applications or  services are running 
simultaneously more will be required. 

HDD SSD 2 GB free plus @1 Gb per 
Noah module.  

Recommended by HIMSA.  

Network  
Adapter  

100 Mb/s 1 Gb/s Network requirements, see below.                         

Graphics  
Adapter  

Widescreen 
16:9  1920 x 
1080

 

Widescreen 16:9  
2560 x 1440

 

Label Printer   Seiko Smart 
Label Printer

Zebra printers are not supported.

 

A.2.2 Software requirements

Software   

Component   

Minimum   Recommended   Comment   

Operating  
System  

Windows 10 
(64 bit)* 

Windows 11*

Windows 11* All Microsoft Updates should be 
installed  

*1) Contact the manufacturer for 
module or audiometer panel 
support;

2) Auditbase was tested on  
versions Win10 (22H2), Win11 
(23H2), Win11 (24H2), Win11 
(25H2).
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Software   

Component   

Minimum   Recommended   Comment   

Ghosting  Ghosting  images of Windows are not supported due to SID issues.  

Document  
editor  

Tested with:

Word for Microsoft 365 MSO (Version 2508 Build 16.0.19127.20314)

PDF generation Microsoft XPS Document Writer must be installed on all clients for 
generating system PDF files.

Bitmap editing 'MS Paint' must be installed for editing audiogram symbols.

Noah  modules  Must be  Noah4 certified.  

Web Browser Web browser Edge, Chrome, Firefox, or Safari is required for viewing online 
IFU and eLearning modules.

Java Not  required.

.Net 4.6.2 (installed with Windows 10)

4.8 (Installed with Windows 11)

Adobe Acrobat 
Reader   

No version requirements 

 

A.3 Client specifications (without Noah installation)
A.3.1 Hardware requirements

Hardware   

Component   

Minimum   Recommended   Comment   

Processor  Core i3 Core i5  

RAM  32 bit: 3.5 GB  

64 bit:  4 GB  

32 bit: 3.5 GB  

64 bit: 8 GB  

If other applications or services are 
running simultaneously more RAM  will 
be required.  

HDD 1 GB free  SSD 3 GB free   

Network  
Adapter  

100 Mb/s  1 Gb/s  Network requirements, see below. 

Graphics  Widescreen Widescreen 16:9   
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Hardware   

Component   

Minimum   Recommended   Comment   

Adapter  16:9  1920 x 
1080

 

2560 x 1440

Label Printer   Seiko Smart 
Label Printer

Zebra printers are not supported.

 

A.3.2 Software requirements

Software   

Component   

Minimum   Recommended   Comment   

Operating  
System  

Windows 10 (64 
bit) *

Windows 11*

Windows 11* All  Microsoft Updates should be 
installed  

*Auditbase was tested on  versions 
Win10 (22H2), Win11 (23H2), Win11 
(24H2), Win11 (25H2).

Ghosting  Ghosting  images of Windows are not supported due to SID issues.  

Document  
editor  

Tested with:

Word for Microsoft 365 MSO (Version 2508 Build 16.0.19127.20314)

PDF 
generation

Microsoft XPS Document Writer must be installed on all clients for generating 
system PDF files.

Bitmap 
editing

'MS Paint' must be installed for editing audiogram symbols.

Web Browser Web browser Edge, Chrome, Firefox, or Safari is required for viewing online 
IFU and eLearning modules.

Java Not  required.

.Net 4.6.2 (installed with Windows 10)

4.8 (Installed with Windows 11)

Adobe 
Acrobat 
Reader   

No version requirements 
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A.4 Security specifications
A.4.1 Encryption

 l Network traffic between the Auditbase database and client PCs can be encrypted using 
TLS1.2.  It is recommended for security that this is requested.

 l The Auditbase SQLBase database can be encrypted. It is recommended for security that 
this is requested.  Note that this may have a detrimental impact on performance.

 l HL7 Interfaces between Auditbase and hospital systems are required to be secured by 
the customers own traffic encryption and protection within their private network domain.

A.4.2 Anti-virus and anti-malware

 l It is essential for security that anti-virus and anti-malware protection is installed on every 
PC where Auditbase is used.  This protection must be updated on a regular basis.

 l It is essential for security that in order to mitigate risks if a PC is infected by a virus or 
malware that users do not have any Administrator level rights in Windows which could be 
taken advantage of by the virus or malware.

A.4.3 Windows authentications and passwords

 l It is essential for security that a method of strong authentication for Windows login is 
employed when Active Directory Windows login is enabled for Auditbase.

 l It is essential for security that a policy for keeping Windows passwords secure is 
enforced.

A.4.4 Security of printouts

 l For security, it is advised that a cover page that could include "PATIENT CONFIDENTIAL 
INFORMATION" is configured on printers where printouts from Auditbase are made.

A.4.5 Port scanning

 l Auditdata suggests which ports to use for Auditdata applications.  These may be changed 
by the customer after discussion with Auditdata support staff on how to reconfigure the 
application.  The customer is responsible for ensuring that port scanning is performed on 
all relevant network interfaces.
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A.5 Network specifications
A.5.1 Network requirements

Bandwidth: Approximately 10Mbit is required per user for the best working experience.

Latency: Performance decreases as latency increases. A latency of 0-20ms is preferred; a 
latency over 35ms will result in real delays noticeable by users. Latency over certain high levels 
(100ms/200ms depending on the network type and application area) will result in connection 
loss and the application will need to be restarted.

Loss of connection: Network connection must be maintained at all times otherwise the 
application will need to be restarted. Auditbase connection licensing does not support 
connection loss and licence number violation may occur in this circumstance.

Loss of packets: TCP handling will cope with a limited loss of packets. A 5% loss will result in a 
noticeable slowdown and around 50% will result in a loss of connection.

A.5.2 Naming Client workstations

Recommendation: Names of workstations should have unique last 8 characters. This is 
needed for efficient tracking of the Auditbase licences in use and, potentially, freeing hanging 
connections of the same user from the same workstation.

 

A.6 Equipment and Network hazards and configuration 
changes
On any equipment and network configuration change, or any patching to, for instance, 
Windows, anti-virus, or firewall software, the customers are strongly advised to carry out 
changes in a way, so that the minimum requirements described above are still met.  
Consideration must also be taken that any changes or patches to the above will still support the 
security goals and security capabilities of the system.

If Auditbase is run on equipment or network not satisfying minimum requirements, that can 
cause the following consequences:

 o Low system performance, which can cause delays in patients’ treatment and information 
disclosure;

 o System crash, which can cause loss of unsaved data.

In general, customers are suggested, that using the system in an environment not satisfying 
minimum requirements can cause previously unidentified risks to patients, users, and third 
parties. Customers are responsible for analyzing and evaluating risks related to providing or 
changing their IT infrastructure.

Changes to the IT-Network include:
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 1. Changes in IT-Network  configuration;
 2. Addition of items (hardware and/or software platforms or software applications) to the IT-

Network;
 3. Removal of items from the IT-Network;
 4. Update of hardware and/or software platforms or software applications on the IT-

Network;
 5. Upgrade of hardware and/or software platforms or software applications on the IT-

Network.

A.7 Information flow
A.7.1 Information flow – Diagram
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A.7.2 Information flow – Assets

Name Description Personal data Storage

Auditbase client 
application (PC)

Auditbase client Windows GUI 
application. Operates  in the local 
area network, connects to the 
Main database.

Yes.

Users read and 
enter personal 
data using this  
application.

No

Auditbase 
Laptop 
application, 
including Local  
database

Auditbase client application 
configured for  operation outside 
the local area network. 

Includes Local database engine 
for storing data.

Yes Yes

Main database The database where all data are 
stored.

The owner of the database is the 
Customer; keeping  the data is the 
Customer’s responsibility.

Yes Yes

Local database The database is used as a part of 
the Auditbase  Laptop application.

Contains data about a very limited 
number of  patients.

The owner of the database is the 
Customer; keeping  the data is the 
Customer’s responsibility.

Yes Yes

Auditbase 
Server 
applications

Various standalone applications 
used for interfacing  purposes.

Yes Depends on the 
used interfaces

External 
systems

Auditbase has interfaces to 
external Information systems.  
That can include:

 o Hospital  Patient 
Administration System (PAS) 
for exchanging 
demographics and 
appointment information.

Yes Yes
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Name Description Personal data Storage

 o Document  storage system.
 o Etc.

 

SMS SMS sent to patients for 
appointment reminders.

Configurable On the patient’s 
mobile phone 
according to their  
configuration

E-mail Documents e-mailed to patients 
and other parties.

Yes Receiver 
responsibility.

 

A.7.3 Information flow – Description

Number Description Personal data 
processed

1 Auditbase client Windows GUI application reads and  writes data 
to the main database; operations are done in the local area  
network.

Yes

 

2 The Auditbase Laptop application (configured for  operation 
outside the local area network) reads data from the main 
database for  further copying it to the Laptop database; it also 
synchronizes modified data  to the main database. These 
operations are done in the local area network.

Yes

3 Auditbase Laptop application (configured for  operation outside 
the local area network)  reads and writes data to the Laptop 
database; operations are done inside a  laptop PC.

Yes

4 Auditbase client Windows GUI application requests  data from 
the Server standalone applications and receives a response.

Yes

5 Auditbase server applications read and write data to  the Main 
database for interfacing needs.

Yes

6 Auditbase server applications exchange data with  external 
systems.

Yes

7 Auditbase server application sends SMS to patients  using E-mail 
or Web services provided by the Customer.

Configurable

8 Auditbase server application sends E-mail to  patients and other Yes
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Number Description Personal data 
processed

parties using the e-mail service provided by the Customer.
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Appendix B  
B.1 Manufacturer and System Data
The SaMD Auditbase System is manufactured and sold in the EU by:

 

Head office:

Auditdata A/S

Wildersgade 10B 1408 København K Denmark

Phone: +45 70203124

www.auditdata.com

 

 

 0123
 

2003 Auditbase 

 

 

Documentation version:

Auditbase Help System  version (IFU) DN02187/13

Symbols used on the system, its packaging, and in documentation:

See the section "Symbols used" for an overview of symbols used.
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B.2 Label signs interpretation
B.2.1 Label sample

 

B.2.2 Key for labelling

Auditbase  Type of the device  

Version 6.9.0  Device version  

Manufacturer’s address  

 0123 CE mark and Notified Body number 

2003 Auditbase Product name (type label) 

Warning in About Box labelling

Medical device

 Electronic instructions for use (e-IFU)

NOTE: The licences list is dynamic and varies according to the licence content for each 
customer.
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